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Chapter 575 

Multiple Comparisons 
Introduction 
This module computes sample sizes for multiple comparison procedures. The term “multiple comparison” refers 
to the individual comparison of two means selected from a larger set of means. The module emphasizes one-way 
analysis of variance designs that use one of three multiple-comparison methods: Tukey’s all pairs (MCA), 
comparisons with the best (MCB), or Dunnett’s all versus a control (MCC). Because these sample sizes may be 
substantially different from those required for the usual F test, a separate module is provided to compute them. 

There are only a few articles in the statistical literature on the computation of sample sizes for multiple 
comparison designs. This module is based almost entirely on the book by Hsu (1996). We can give only a brief 
outline of the subject here. Users who want more details are referred to Hsu’s book. 

Although this module is capable of computing sample sizes for unbalanced designs, it emphasizes balanced 
designs. 

Technical Details 

The One-Way Analysis of Variance Design 
The summarized discussion that follows is based on the common, one-way analysis of variance design. Suppose 
the responses  in k groups each follow a normal distribution with respective means, , and 

unknown variance, . Let  denote the number of subjects in each group.  

The analysis of these responses is based on the sample means 

 

and the pooled sample variance 

 

The F test is the usual method for analyzing such a design, and tests whether all of the means are equal. However, 
a significant F test does not indicate which of the groups are different, only that at least one is different. The 
analyst is left with the problem of determining which group(s) is(are) different and by how much.  

The probability statement associated with the F test is simple, straightforward, and easy to interpret. However, 
when several simultaneous comparisons are made among the group means, the interpretation of individual 
probability statements becomes much more complex. This is called the problem of multiplicity. Multiplicity here 
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refers to the fact that the probability of making at least one incorrect decision increases as the number of statistical 
tests increases. The method of multiple comparisons has been developed to account for such multiplicity. 

Power Calculations for Multiple Comparisons 
For technical reasons, the definition of power in the case of multiple comparisons is different from the usual 
definition. Following Hsu (1996) page 237, power is defined as follows.  

Using a  simultaneous confidence interval multiple comparison method, power is the probability that the 
confidence intervals cover the true parameter values and are sufficiently narrow. Power is still defined to be 

. Note that . Here, narrow refers to the width of the confidence intervals. The definition says 
that the confidence intervals should be as narrow as possible while still including the true parameter values. This 
definition may be restated as the probability that the simultaneous confidence intervals are correct and useful. 

The parameter  represents the maximum width of any of the individual confidence intervals in the set of 
simultaneous confidence intervals. Thus,  is used to specify the narrowness of the confidence intervals. 

Multiple Comparisons with a Control (MCC) 
A common experimental design compares one or more treatment groups with a control group. The control group 
may receive a placebo, the standard treatment, or even an experimental treatment. The distinguishing feature is 
that the mean response of each of the other groups is to be compared with this control group.  

We arbitrarily assume that the last group (group k), is the control group. The k-1 parameters of primary interest 
are 

 

In this situation, Dunnett’s method provides simultaneous, one- or two-sided confidence intervals for all of these 
parameters.  

The one-sided confidence intervals, , are specified as follows: 

 

where 

 

and q, found by numerical integration, is the solution to 

 

where  is the standard normal distribution function and  is the density of . 
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The two-sided confidence intervals for  are specified as follows: 

 

where 

 
and |q|, found by numerical integration, is the solution to 

 

where  is the standard normal distribution function and  is the density of . 

Interpretation of Dunnett’s Simultaneous Confidence Intervals 
There is a specific interpretation given for Dunnett’s method. It provides a set of confidence intervals calculated 
so that, if the normality and equal-variance assumptions are valid, the probability that all of the k-1 confidence 
intervals enclose the true values of  is . The presentation below is for the two-sided case. The 
one-sided case is the same as for the MCB case.  

Sample Size and Power – Balanced Case 
Using the modified definition of power, the two-sided case is outlined as follows. 

 

where 

 

This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of  that you want to detect, 

the group sample size, n, the power, , the significance level, , and the within-group standard deviation, . 
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Sample Size and Power – Unbalanced Case 
Using the modified definition of power, the unbalanced case is outlined as follows. 
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where 

 
This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of  that you want to detect, 

the group sample sizes, , the power, , the significance level, , and the within-group standard 
deviation, . 

Multiple Comparisons with the Best (MCB) 
The method of multiple comparisons with the best (champion) is used in situations in which the best group (we 
will assume the best is the largest, but it could just as well be the smallest) is desired. Because of sampling 
variation, the group with the largest sample mean may not actually be the group with the largest population mean. 
The following methodology has been developed to analyze data in this situation.  

Perhaps the most obvious way to define the parameters in this situation is as follows 

 

Obviously, the group for which all of these values are positive will correspond to the group with the largest mean.  

Another way of looking at this, which has some advantages, is to use the parameters 

 

since, if , group i is the best.  

Hsu (1996) recommends using constrained MCB inference in which the intervals are constrained to include zero. 
Hsu recommends this because inferences about which group is best are sharper. For example, a confidence 
interval for  whose lower limit is 0 indicates that group i is the best. Similarly, a confidence interval for  
whose upper limit is 0 indicates that group i is not the best. 
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Hsu (1996) shows that  simultaneous confidence intervals for  are given by 

 

where  is found using Dunnett’s one-sided procedure discussed above assuming that group i is the control 
group. 

Sample Size and Power – Balanced Case  
Using the modified definition of power, the balanced case is outlined as follows 
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where 

 

This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of  that you want to detect, 

the group sample size, n, the power, , the significance level, , and the within-group standard deviation, . 
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Sample Size and Power – Unbalanced Case 
Using the modified definition of power, the unbalanced case is outlined as follows 

 

where 

 
This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of  that you want to detect, 

the group sample sizes, , the power, , the significance level, , and the within-group standard 
deviation, . 

All-Pairwise Comparisons (MCA) 
In this case you are interested in all possible pairwise comparisons of the group means. There are k(k-1)/2 such 
comparisons. A popular method in this case is that developed by Tukey.  

Balanced Case  
The Tukey method provides simultaneous, two-sided confidence intervals. They are specified as follows 
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where  is the standard normal distribution function and  is the density of . Note that 

 is the critical value of the Studentized range distribution. 

Sample Size and Power  
Using the modified definition of power, the balanced case is outlined as follows 

 

where 

 
This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of  that you want to detect, 

the group sample size, n, the power, , the significance level, , and within-group standard deviation, . 

Unbalanced Case  
The simultaneous, two-sided confidence intervals are specified as follows 

 

Unfortunately,  cannot be calculated as a double integral as in previous cases. Instead, the Tukey-Kramer 

approximate solution is used. Their proposal is to use  in place of .  

Sample Size and Power  
Using the modified definition of power, the unbalanced case is outlined as follows 
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where 

 
This calculation is made using the algorithm developed by Hsu (1996). 

To reiterate, this calculation requires you to specify the minimum value of  that you want to detect, 

the group sample sizes, , the power, , the significance level, , and the within-group standard 
deviation, . 

 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be solved for using the other parameters. Under most situations you will 
select either Power for a power analysis or Sample Size for sample size determination. 

Test 

Type of Multiple Comparison 
Specify the type of multiple comparison test to be analyzed. The tests available are 

• All Pairs - Tukey Kramer 
All possible paired comparisons. 

• With Best - Hsu 
Constrained comparisons with the best. 

• With Control - Dunnett 
Two-sided versus a control group. 
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Power and Alpha 

Power  
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. In the case of multiple comparisons, power is the probability that the confidence 
intervals will cover the true parameter values and be sufficiently narrow to be useful. This is a modified definition 
of power; since beta equals 1-power, it is has a modified definition as well. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal 
means when in fact the means are equal.  

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that 
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents 
the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 

 

Sample Size / Groups – Sample Size Multiplier 

n (Sample Size Multiplier) 
This is the base, per-group sample size. One or more values separated by blanks or commas may be entered. A 
separate analysis is performed for each value listed here. 

The group samples sizes are determined by multiplying this number by each of the Group Sample Size Pattern 
numbers. If the Group Sample Size Pattern numbers are represented by m1, m2, m3, …, mk and this value is 
represented by n, the group sample sizes N1, N2, N3, ..., Nk are calculated as follows: 

N1=[n(m1)] 

N2=[n(m2)] 

N3=[n(m3)] 

etc. 

where the operator, [X] means the next integer after X, e.g. [3.1]=4. 

For example, suppose there are three groups and the Group Sample Size Pattern is set to 1,2,3. If n is 5, the 
resulting sample sizes will be 5, 10, and 15. If n is 50, the resulting group sample sizes will be 50, 100, and 150. If 
n is set to 2,4,6,8,10, five sets of group sample sizes will be generated and an analysis run for each. These sets are: 

2 4 6 
4 8 12 
6 12 18 
8 16 24 
10 20 30 
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As a second example, suppose there are three groups and the Group Sample Size Pattern is 0.2,0.3,0.5. When the 
fractional Pattern values sum to one, n can be interpreted as the total sample size of all groups and the Pattern 
values as the proportion of the total in each group.  

If n is 10, the three group sample sizes would be 2, 3, and 5. 

If n is 20, the three group sample sizes would be 4, 6, and 10. 

If n is 12, the three group sample sizes would be 

(0.2)12 = 2.4 which is rounded up to the next whole integer, 3. 

(0.3)12 = 3.6 which is rounded up to the next whole integer, 4. 

(0.5)12 = 6.  

Note that in this case, 3+4+6 does not equal n (which is 12). This can happen because of rounding. 

Sample Size / Groups – Groups 

k (Number of Groups) 
This is the number of group means being compared. It must be greater than or equal to three.  

You can enter a list of values, in which case a separate analysis will be calculated for each value. Commas or 
blanks may separate the numbers. A TO-BY list may also be used. 

Note that the number of items used in the Hypothesized Means box and the Group Sample Size Pattern box is 
controlled by this number. 

Examples: 

3,4,5 

4 5 6 

3 to 11 by 2 

Group Sample Size Pattern 
A set of positive, numeric values (one for each group) is entered here. The sample size of group i is found by 
multiplying the ith number from this list times the value of n and rounding up to the next whole number. The 
number of values must match the number of groups, k. When too few numbers are entered, 1’s are added. When 
too many numbers are entered, the extras are ignored. 

Note that in the case of Dunnett’s test, the last group corresponds to the control group. Thus, if you want to study 
the implications of having a group with a different sample size for the control group, you should specify that 
sample size in the last position. 

• Equal 
If all sample sizes are to be equal, enter “Equal” here and the desired sample size in n. A set of k 1's will be 
used. This will result in N1 = N2 = N3 = n. That is, all sample sizes are equal to n.  
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Effect Size 

Minimum Detectable Difference 
Specify one or more values of the minimum detectable difference. This is the smallest difference between any two 
group means that is to be detectable by the experiment. Note that this is a positive amount. This value is set by the 
researcher to represent the smallest difference between two means that will be of practical significance to other 
researchers. Note that in the case of Dunnett’s test, this is the maximum difference between each treatment and 
the control.  

Examples: 

3 

3 4 5 

10 to 20 by 2 

S (Standard Deviation of Subjects) 
This option refers to , the standard deviation within a group. It represents the variability from subject to subject 
that occurs when the subjects are treated identically. It is assumed to be the same for all groups. This value is 
approximated in an analysis of variance table by the square root of the mean square error. 

Since they are positive square roots, the numbers must be strictly greater than zero. You can press the SD button 
to obtain further help on estimating the standard deviation. 

Note that if you are using this procedure to test a factor (such as an interaction) from a more complex design, the 
value of standard deviation is estimated by the square root of the mean square of the term that is used as the 
denominator in the F test.  

You can enter a list of values separated by blanks or commas, in which case a separate analysis will be calculated 
for each value. 

Examples of valid entries: 

1,4,7,10 

1 4 7 10 

1 to 10 by 3 

Options Tab 
The Options tab contains a search precision option. 

Precision 

Search Precision 
Specify the precision to be used in the routines that search for the value of the minimum detectable difference. 
Note that the closer this value is to zero, the longer a search will take. 

  

σ
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Example 1 – Calculating Power 
An experiment is being designed to compare the means of four groups using the Tukey-Kramer pairwise multiple 
comparison test with a significance level of 0.05. Previous studies indicate that the standard deviation is 5.3. The 
typical mean response level is 63.4. The researcher believes that a 25% increase in the mean will be of interest to 
others. Since 0.25(63.4) = 15.85, this is the number that will be used as the minimum detectable difference.   

To better understand the relationship between power and sample size, the researcher wants to compute the power 
for several group sample sizes between 2 and 14. The sample sizes will be equal across all groups.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Multiple Comparisons procedure window by expanding Means, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons. You may then make the appropriate entries as listed 
below, or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Type of Multiple Comparison .................. All Pairs - Tukey Kramer 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... 2 to 14 by 2 
k (Number of Groups) ............................. 4 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference ............. 15.85 
S (Standard Deviation of Subjects) ........ 5.3 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results Report 
 

Numeric Results for Multiple Comparison Test: Tukey-Kramer (Pairwise) 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.0113 2.00 4 8 0.0500 0.9887 15.85 5.30 2.9906 
0.0666 4.00 4 16 0.0500 0.9334 15.85 5.30 2.9906 
0.3171 6.00 4 24 0.0500 0.6829 15.85 5.30 2.9906 
0.7371 8.00 4 32 0.0500 0.2629 15.85 5.30 2.9906 
0.9301 10.00 4 40 0.0500 0.0699 15.85 5.30 2.9906 
0.9497 12.00 4 48 0.0500 0.0503 15.85 5.30 2.9906 
0.9500 14.00 4 56 0.0500 0.0500 15.85 5.30 2.9906 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
n is the average group sample size. 
k is the number of groups. 
Total N is the total sample size of all groups. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
The Minimum Detectable Difference between any two group means. 
S is the within group standard deviation. 
The Diff / S is the ratio of Min. Detect. Diff. to standard deviation. 
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Summary Statements 
In a single factor ANOVA study, sample sizes of 2, 2, 2, and 2 are obtained from the 4 groups 
whose means are to be compared. The total sample of 8 subjects achieves 1% power to detect a 
difference of at least 15.85 using the Tukey-Kramer (Pairwise) multiple comparison test at a 
0.0500 significance level. The common standard deviation within a group is assumed to be 5.30. 
 

This report shows the numeric results of this power study. Following are the definitions of the columns of the 
report. 

Power 
This is the probability that the confidence intervals will cover the true parameter values and be sufficiently narrow 
to be useful. 

Average n 
The average of the group sample sizes. 

k 
The number of groups. 

Total N 
The total sample size of the study. 

Alpha 
The probability of rejecting a true null hypothesis. This is often called the significance level. 

Beta 
Equal to 1- power. Note the definition of power above. 

Minimum Detectable Difference 
This is the value of the minimum detectable difference. This is the minimum difference between two means that is 
thought to be of practical importance. Note that in the case of Dunnett’s test, this is the minimum difference 
between a treatment mean and the control mean that is of practical importance. 

Standard Deviation (S) 
This is the within-group standard deviation. It was set in the Data window. 

Diff / S 
This is an index of relative difference between the means standardized by dividing by the standard deviation. This 
value can be used to make comparisons among studies. 

Detailed Results Report 
 

Tukey-Kramer Test Details   
  Percent   Minimum  
  n of   Detectable Standard 
Group n Total N Alpha Power Difference Deviation 
1 2 25.00 0.0500 0.0113 15.85 5.30 
2 2 25.00     
3 2 25.00     
4 2 25.00     
Total 8 100.00 
 

This report shows the details of each row of the previous report. 

Group 
The group identification number is shown on each line. The second to the last line represents the last group. When 
Dunnett’s test has been selected, this line represents the control group. 
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The last line, labeled Total, gives the total for all the groups. 

n 
This is the sample size of each group. This column is especially useful when the sample sizes are unequal. 

Percent n of Total N 
This is the percentage of the total sample that is allocated to each group. 

Alpha 
The probability of rejecting a true null hypothesis. This is often called the significance level. 

Power 
This is the probability that the confidence intervals will cover the true parameter values and be sufficiently narrow 
to be useful. 

Minimum Detectable Difference 
This is the value of the minimum detectable difference. This is the minimum difference between two means that is 
thought to be of practical importance. Note that in the case of Dunnett’s test, this is the minimum difference 
between a treatment mean and the control mean that is of practical importance. 

Standard Deviation (S) 
This is the within-group standard deviation. It was set in the Data window. 

Plots Section 
 

 
 

This plot gives a visual presentation to the results in the Numeric Report. We can see the impact on the power of 
increasing the sample size. 

When you create one of these plots, it is important to use trial and error to find an appropriate range for the 
horizontal variable so that you have results with both low and high power. 
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Example 2 – Power after Dunnett’s Test 
This example covers the situation in which you are calculating the power of Dunnett’s test on data that have 
already been collected and analyzed. 

An experiment included a control group and two treatment groups. Each group had seven individuals. A single 
response was measured for each individual and recorded in the following table. 
 

Control T1 T2 
554 774 786 
447 465 536 
356 759 653 
452 646 685 
674 547 658 
654 665 669 

 

When analyzed using the one-way analysis of variance procedure in NCSS, the following results were obtained.  
   
 Analysis of Variance Table  
   
 Source  Sum of Mean  Prob 
 Term DF Squares Square F-Ratio Level  
 A ( ... ) 2 75629.8 37814.9 3.28 0.061 
 S(A) 18 207743.4 11541.3 
 Total (Adjusted) 20 283373.3 
 Total 21 
 

Dunnett's Simultaneous Confidence Intervals for Treatment vs. Control 
Response: Control,T1,T2 
Term A:  
Control Group: Control 
Alpha=0.050  Error Term=S(A)  DF=18  MSE=11541.3 Critical Value=2.3987 
 
Treatment   Lower 95.0% Difference Upper 95.0% Test 
Group Count Mean Simult.C.I. With Control Simult.C.I. Result 
T1 7 660.43 -5.17 132.57 270.31  
T2 7 649.14 -16.46 121.29 259.03 

 

The significance level (Prob Level) was only 0.061—not enough for statistical significance. Since the lower 
confidence limits are negative and the upper confidence limits are positive, Dunnett’s two-sided test did not find a 
significant difference between either treatment and the control group. 
The researcher had hoped to show that the treatment groups had higher response levels than the control group. He 
could see that the group means followed this pattern since the mean for T1 was about 25% higher than the control 
mean and the mean for T2 was about 23% higher than the control mean. He decided to calculate the power of the 
experiment. 

Setup 
The data entry for this problem is simple. The only entry that is not straight forward is finding an appropriate 
value for the standard deviation. Since the standard deviation is estimated by the square root of the mean square 
error, it is calculated as . 

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Multiple Comparisons procedure window by expanding Means, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons. You may then make the appropriate entries as listed 
below, or open Example 2 by going to the File menu and choosing Open Example Template. 

  

11541.3 = 107 4304.
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Option Value 
Design Tab 
Solve For ................................................ Power 
Type of Multiple Comparison .................. With Control - Dunnett 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... 7 
k (Number of Groups) ............................. 3 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference ............. 133 
S (Standard Deviation of Subjects) ........ 107.4304 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.0002 7.00 3 21 0.0500 0.9998 133.00 107.43 1.2380 

 

The power is only 0.0002. Hence, there was little chance of detecting a difference of 133 between a treatment and 
a control group.  
It was of interest to the researcher to determine how large of a sample was needed if the power was to be 0.90. 
Setting Beta equal to 0.90 and ‘Find/Solve For’ to n resulted in the following report. 
 

 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9042 33.00 3 99 0.0500 0.0958 133.00 107.43 1.2380 

 

We see that instead of 7 per group, 33 per group were needed. 
It was also of interest to the research to determine how large of a difference between the means could have been 
detected. Setting ‘Find’ to Min Detectable Difference resulted in the following report. 
 

 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9000 7.00 3 21 0.0500 0.1000 348.81 107.43 3.2468 

 

We see that a study of this size with these parameters could only detect a difference of 348.8. This explains why 
the results were not significant. 
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Example 3 – Using Unequal Sample Sizes 
It is usually advisable to design experiments with equal sample sizes in each group. In some cases, however, it 
may be necessary to allocate subjects unequally across the groups. This may occur when the group variances are 
unequal, the costs per subject are different, or the dropout rates are different. This module can be used to study the 
power of unbalanced experiments. 

In this example which will use Dunnett’s test, the minimum detectable difference is 2.0, the standard deviation is 
1.0, alpha is 0.05, and k is 3. The sample sizes are 7, 7, and 14. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Multiple Comparisons procedure window by expanding Means, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons. You may then make the appropriate entries as listed 
below, or open Example 3a by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Type of Multiple Comparison .................. With Control - Dunnett 
Alpha ....................................................... 0.05 
n (Sample Size Multiplier) ....................... 1 
k (Number of Groups) ............................. 3 
Group Sample Size Pattern .................... 7 7 14 
Minimum Detectable Difference ............. 2 
S (Standard Deviation of Subjects) ........ 1 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.2726 9.33 3 28 0.0500 0.7274 2.00 1.00 2.0000 
 

Alternatively, this problem could have been set up as follows (Example3b template): 

Option Value 
Data Tab 
n (Sample Size Multiplier) ....................... 7 
Group Sample Size Pattern .................... 1 1 2 
 

The advantage of this method is that you can try several values of n while keeping the same allocation ratios.  
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Example 4 – Validation using Hsu 
Hsu (1996) page 241 presents an example of determining the sample size in an experiment with 8 groups. The 
minimum detectable difference is 10,000 psi. The standard deviation is 3,000 psi. Alpha is 0.05 and beta is 0.10. 
He finds a sample size of 10 per group for the Tukey-Kramer test, a sample size of 6 for Hsu’s test, and a sample 
size of 8 for Dunnett’s test.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Multiple Comparisons procedure window by expanding Means, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons. You may then make the appropriate entries as listed 
below, or open Example4, Example4b, or Example4c by going to the File menu and choosing Open Example 
Template.  

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Type of Multiple Comparison .................. All Pairs - Tukey Kramer 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
k (Number of Groups) ............................. 8 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference ............. 10000 
S (Standard Deviation of Subjects) ........ 3000 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results for Tukey-Kramer Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9397 10.00 8 80 0.0500 0.0603 10000.00 3000.00 3.3333 

 
PASS also found n = 10.  

Numeric Results for Hsu’s Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9087 6.00 8 48 0.0500 0.0913 10000.00 3000.00 3.3333 
 

PASS also found n = 6.  

Numeric Results for Dunnett’s Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9434 8.00 8 64 0.0500 0.0566 10000.00 3000.00 3.3333 

 
PASS found n = 8.  

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Multiple Comparisons 

575-19 
 © NCSS, LLC. All Rights Reserved. 

Example 5 – Validation using Pan and Kupper 
Pan and Kupper (1999, page 1481) present examples of determining the sample size using alternative methods. It 
is interesting to compare the method of Hsu (1996) with theirs. Although the results are not exactly the same, they 
are very close. 

In the example of Pan and Kupper, the minimum detectable difference is 0.50. The standard deviation is 0.50. 
Alpha is 0.05, and beta is 0.10. They find a sample size of 51 per group for Dunnett’s test and a sample size of 60 
for the Tukey-Kramer test. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Multiple Comparisons procedure window by expanding Means, then clicking on Multiple 
Comparisons, and then clicking on Multiple Comparisons. You may then make the appropriate entries as listed 
below, or open Example5a or Example 5b by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Type of Multiple Comparison .................. With Control - Dunnett 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
k (Number of Groups) ............................. 4 
Group Sample Size Pattern .................... Equal 
Minimum Detectable Difference ............. 0.50 
S (Standard Deviation of Subjects) ........ 0.50 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results for Dunnett’s Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9146 53.00 4 212 0.0500 0.0854 0.50 0.50 1.0000 
 

PASS found n = 53. This is very close to the 51 that Pan and Kupper found using a slightly different method. 

Numeric Results for Tukey-Kramer Test 
 
 Average     Minimum Standard  
 Size  Total   Detectable Deviation  
Power (n) k N Alpha Beta Difference (S) Diff / S 
0.9057 62.00 4 248 0.0500 0.0943 0.50 0.50 1.0000 
 

PASS also found n = 62. This is very close to the 60 that Pan and Kupper found using a slightly different method. 
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